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Thank you for choosing Epiphan!  

At Epiphan Systems Inc. (“Epiphan”), product function and quality are our top 

priority. We make every effort to make sure that our products exceed our 

customers’ expectations.  

Product Feedback  

We regularly contact our customers to ensure product performance and 

reliability. We strive to continually enhance our products to accommodate your 

needs. We welcome your feedback and suggestions for product improvements. 

You can email your comments to info@epiphan.com. 

Specifications  

You can go to the Frame Grabbers page of the Epiphan website to get 

information about DVI2PCIe.  

Warranty  

All Epiphan Systems products are provided with a 100% return to depot warranty 

for one year from the date of purchase.  

Technical Support  

Epiphan is staffed by a professional support team. If, after checking the FAQs 

for your product on the Epiphan website and re-installing the Epiphan driver 

software (where applicable), you continue to have outstanding issues, email a 

problem report to support@epiphan.com. To help us solve the problem 

efficiently, include the following info:  

• Your DVI2PCIe serial number.  

• Technical description of the signal source including resolution, refresh 

rate, synchronization, type of hardware.  

• Complete description of the problem you are experiencing.  

 

Copyright © 2017 Epiphan Systems Inc. All Rights Reserved. 

  

 
 
 

  

mailto:info@epiphan.com
http://www.epiphan.com/products/frame-grabbers/
mailto:support@epiphan.com
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Terms and Conditions 

This document, the Epiphan web site, and the information contained therein, 
including but not limited to the text and images as well as Epiphan Systems 
Inc's trademarks, trade names and logos are the property of Epiphan and its 
affiliates and licensors, and are protected from unauthorized copying and 
dissemination by Canadian copyright law, United States copyright law, 
trademark law, international conventions and other intellectual property laws.  
 
Epiphan, Epiphan Systems, Epiphan Systems Inc., and Epiphan logos are 
trademarks or registered trademarks of Epiphan Systems Inc., in certain 
countries. All Epiphan product names and logos are trademarks or registered 
trademarks of Epiphan. All other company and product names and logos may 
be trademarks or registered trademarks of their respective owners in certain 
countries.  

 

Copyright © 2017 Epiphan Systems Inc. All Rights Reserved. 

 

THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE 

ACCOMPANYING PRODUCT ARE SET FORTH IN THE INFORMATION 

PACKET OR PRODUCT INSTALLATION SOFTWARE PACKAGE THAT 

SHIPPED WITH THE PRODUCT AND ARE INCORPORATED HEREIN BY 

REFERENCE.  IF YOU ARE UNABLE TO LOCATE THE SOFTWARE LICENSE 

OR LIMITED WARRANTY, CONTACT YOUR EPIPHAN REPRESENTATIVE 

FOR A COPY. 

 

PRODUCT DESCRIPTIONS AND SPECIFICATIONS REGARDING THE 

PRODUCTS IN THIS MANUAL ARE SUBJECT TO CHANGE WITHOUT 

NOTICE. EPIPHAN PERIODICALLY ADDS OR UPDATES THE INFORMATION 

AND DOCUMENTS ON ITS WEB SITE WITHOUT NOTICE. ALL 

STATEMENTS, INFORMATION AND RECOMMENDATIONS ARE BELIEVED 

TO BE ACCURATE AT TIME OF WRITING BUT ARE PRESENTED WITHOUT 

WARRANTY OF ANY KIND, EXPRESS OR IMPLIED.  USERS MUST TAKE 

FULL RESPONSIBILITY FOR THEIR APPLICATION OF ANY PRODUCTS. 

 

LIMITATION OF LIABILITY 

UNDER NO CIRCUMSTANCES SHALL EPIPHAN BE LIABLE FOR ANY 

INCIDENTAL, SPECIAL, CONSEQUENTIAL, EXEMPLARY OR OTHER 

INDIRECT DAMAGES THAT RESULT FROM THE USE OF, OR THE INABILITY 

TO USE, THIS PRODUCT OR THE INFORMATION CONTAINED ON THIS 

DOCUMENT OR PROVIDED ON EPIPHAN’S WEB SITE, EVEN IF EPIPHAN 

HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO 

EVENT SHALL EPIPHAN'S TOTAL LIABILITY TO YOU FOR ALL DAMAGES, 

LOSSES, AND CAUSES OF ACTION RESULTING FROM YOUR USE OF THIS 

PRODUCT, WHETHER IN CONTRACT, TORT (INCLUDING, BUT NOT 
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LIMITED TO, NEGLIGENCE) OR OTHERWISE, EXCEED THE AMOUNTS YOU 

PAID TO EPIPHAN DURING THE MOST RECENT THREE-MONTH PERIOD IN 

CONNECTION WITH AMOUNTS WHICH YOU PAID FOR USING THIS 

PRODUCT. 

 

INFORMATION AND DOCUMENTS, INCLUDING PRODUCT 

SPECIFICATIONS, PROVIDED IN THIS DOCUMENT OR THE EPIPHAN WEB 

SITE ARE PROVIDED "AS IS." SPECIFICALLY, BUT WITHOUT LIMITATION, 

EPIPHAN DOES NOT WARRANT THAT: (i) THE INFORMATION IS CORRECT, 

ACCURATE, RELIABLE OR COMPLETE; (ii) THE FUNCTIONS CONTAINED 

ON THE EPIPHAN WEB SITE WILL BE UNINTERRUPTED OR ERROR-FREE; 

(iii) DEFECTS WILL BE CORRECTED, OR (iv) THIS WEB SITE OR THE 

SERVER(S) THAT MAKES IT AVAILABLE ARE FREE OF VIRUSES OR 

OTHER HARMFUL COMPNENTS. EPIPHAN SPECIFICALLY DISCLAIMS ALL 

REPRESENTATIONS, WARRANTIES AND CONDITIONS, EITHER EXPRESS, 

IMPLIED, STATUTORY, BY USAGE OF TRADE OR OTHERWISE INCLUDING 

BUT NOT LIMITED TO ANY IMPLIED WARRANTIES OF MERCHANTABILITY, 

NON-INFRINGEMENT, TITLE, SATISFACTORY QUALITY OR FITNESS FOR A 

PARTICULAR PURPOSE. 

 

For additional terms and conditions, please refer to additional sections in this 
document. 
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1. Introduction  
Epiphan Systems’ DVI2PCIe™ is Epiphan's capture card internal frame grabber with a 

single-link DVI/VGA input. It is installed in a video capture workstation’s PCI Express 

(PCIe) slot and transmits captured data to the video capture workstation over the PCIe 

bus. 

 

DVI2PCIe can capture video from any single link DVI, unencrypted HDMI video, VGA, 

or BNC/component video source. Full HD can be captured at a capture rate of 30 

frames per second for 1080p video and video sources at any resolution up to 

1920x1200 are supported.  The DVI2PCIe capture card driver is fully compatible with 

DirectShow in Windows, Video4Linux in Linux, and can be used in conjunction with 

any third party software. 

 

Besides being able to capture from DVI, VGA, HDMI video sources, DVI2PCIe 

supports DisplayPort, Mini DisplayPort, and Thunderbolt sources using a converter 

cable, sold separately. Resolutions up to 1920x1200 are supported, with a minimum 

capture rate of 30 frames per second. 

 

DVI2PCIe is part of Epiphan’s complete line of video signal capture products.  For 

more information about all of Epiphan’s video signal capture products, please see 

the Frame Grabbers Overview on the Epiphan website.  

  

1.1 Package Contents 
 

Epiphan DVI2PCIe device package includes the following: 

 

1. DVI2PCIe  board (with tall PCIe bracket attached) 

2. DVI cable 

3. DVI-VGA cable 

4. HDMI  to DVI adapter 

http://www.epiphan.com/products/frame-grabbers/
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5. ½ bracket  

  

Package contents for the DVI2PCIe is available on the DVI2PCIe specifications page 

on the Epiphan website.  

  

http://www.epiphan.com/products/dvi-frame-grabbers/dvi2pcie/specifications/
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2 Physical Attributes 

2.1 System Hardware Features 
 

The Epiphan DVI2PCIe frame grabber is a PCIe x4 card that includes a single DVI-I 

type connector and three activity LEDs. The DVI2PCIe card can be installed in a 4x, 

8x or 16x PCIe slot on the motherboard of the video capture workstation.  

 
 
Figure 1 DVI2PCIe Capture card 
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Figure 2 DVI2PCIe connectors and LEDs 

 
 

 

 

Figure 3 shows an example of different PCIe slots on a single PC motherboard. 
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Figure 3 PCIe slots (from top to bottom: 4x, 16x, 1x and 16x), compared to a traditional 32-
bit PCI slot (bottom) 

 
 

When installed, the DVI2PCIe card adds a single DVI IN port and three LED indicators 

on the back of the PC. You can connect a DVI source directly to this DVI IN port using 

a standard DVI cable. To connect a VGA source, use a VGA to DVI cable. To connect 

an HDMI source, use an HDMI to DVI adapter. 

 
Table 1 LED Descriptions 

Interface Description 

LEDs Red LED:  During operation the red LED blinks each time the 

DVI2PCIe captures an image. You can use the red LED as 

an indicator that the DVI2PCIe is capturing images. 

Green and blue LEDs:  When the PC starts up the DVI2PCIe 

blue LED lights up. A few seconds later the green LED lights 

up. After about another 20 seconds the blue LED turns off, 

leaving the green LED on indicating that the device has 

started up and can start capturing images. During operation 

the blue LED blinks during the signal test operation and when 

the system tunes the parameters. 
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DVI In Connect a DVI, VGA, or HDMI source to the DVI2PCIe card. 

See the DVI2PCIe Specifications on the Epiphan web site for 

information about the video inputs supported by the 

DVI2PCIe card. 

 

 

2.2 Cables, Connectors and Adapters 
 

The DVI2PCIe can be connected to a number of different types of equipment using a 

variety of cables, and adapters. This section describes a subset of connectors, cables 

and adapters that are known to be compatible with the DVI2PCIE.   

 

2.2.1 VGA to DVI Cable   
 

Connects a VGA source to the DVI2PCIE DVI port. This cable is included with the 

DVI2PCIe. 

 
Figure 4 VGA to DVI Cable 

 
 

http://www.epiphan.com/products/dvi-frame-grabbers/dvi2pcie/specifications/
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2.2.2 DVI to DVI Cable 
 

Connects a DVI source to the DVI2PCIe DVI port. This cable is included with the 

DVI2PCIe. 

 
Figure 5 DVI to DVI Cable 

 

2.2.3 HDMI to DVI Adapter 

 

Connects an HDMI source to the DVI2PCIe DVI port. This adapter is included with the 

DVI2PCIe. 

 
Figure 6 HDMI to DVI Adapter 

 



Physical Attributes  

 
10 DVI2PCIe User Guide 

 

2.2.4 DisplayPort Cable 

 Connects a source’s DisplayPort to the DVI2PCIe DVI port.  

 
Figure 7 DisplayPort Cable 

 
 

2.2.5 Mini DisplayPort Cable 

Connects a source’s Mini DisplayPort to the DVI2PCIe DVI port.  

 
Figure 8 Mini DisplayPort Cable 
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2.2.6 Thunderbolt Port Cable 

Connects a source’s Thunderbolt port to the DVI2PCIe DVI port.  

 
Figure 9 Thunderbolt Port Cable 

 
 
 
  



System Requirements  

 
12 DVI2PCIe User Guide 

 

 

3 System Requirements 
Epiphan’s DVI2PCIe internal frame grabber has the following hardware and software 

requirements: 

Video source any VESA-compatible VGA, DVI, or HDMI 

source 

Video capture workstation 4x PCIe slot (4x, 8x or 16x are supported) 

Processor frequency  2 GHz or faster 32-bit (x86) or 64-bit (x64) 

processor 

RAM memory  2 GB RAM (32-bit and 64-bit) 

 

Available hard disk space 16 GB available hard disk space (32-bit) or 20 

GB (64-bit) 

Video capture workstation OS Windows 7, 8, 10 (i386, x64);  

Linux (x86, x86_64);  

A list of precompiled drivers is available on 

the Software Download page. 

 

To download the latest versions of the DVI2PCIe’s drivers and application, browse to 

http://www.epiphan.com/products/dvi-frame-grabbers/dvi2pcie/software-download/. 

  

  

http://www.epiphan.com/products/dvi-frame-grabbers/dvi2pcie/software-download/
http://www.epiphan.com/products/dvi-frame-grabbers/dvi2pcie/software-download/
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4 Installing DVI2PCIe 
 

This section describes how to install the DVI2PCIe and to connect a DVI/VGA/HDMI 

source to it.  

Note: It is recommended that you download and install the latest drivers for the video 

capture workstation motherboard from the motherboard manufacturer’s website after 

installing the DVI2PCIe internal frame grabber into the video capture workstation. 

 

To connect the DVI2PCIe card, in addition to the frame grabber itself you need: 

• A video capture workstation with an available 4x, 8x or 16x PCIe 

slot. 

• A DVI/VGA/HDMI video source.  

• For VGA and HDMI video sources, the appropriate cable or adapter 

to connect the video source input to the DVI IN port. 

• An antistatic wrist strap to protect sensitive electronic components. 

4.1.1 To install a DVI2PCIe Frame Grabber: 

This procedure describes how to install the DVI2PCIe in a video capture workstation. 

 

1. Shut down and power off the video capture workstation. 

2. Disconnect all cables from the video capture workstation. 

3. Open the system unit to expose the PCIe slots (usually located at the back of 

the PC). 

4. Attach the antistatic wrist strap to the metal casing of the PC power supply 

and to your wrist according to the instructions supplied with the wrist strap. 

5. Select a PCIe slot and remove the corresponding filler panel from the PC slot 

opening. 

6. Holding the DVI2PCIe card by the edges, align the card edge connector with 

the PCIe slot. 
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7. Slide the card mounting bracket into the small slot at the end of the PCIe 

opening. 

8. Applying even pressure at both corners of the card, push the card down until 

it is firmly seated in the slot. 

Caution: Do not use excessive force when installing the card into the PCIe slot. You 

might damage the card’s PCIe connector. If the card does not seat properly when you 

apply even pressure, remove the card and carefully reinstall it. 

9. Secure the card mounting bracket to the system unit using a screw at the top 

of the mounting bracket. 

10.  Detach the wrist strap and close the system unit. 

11. Power on the video capture workstation. 

12.  Install the DVI2PCIe drivers and application as described below.  
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5 Installation Steps for the Windows Video 
Capture Workstation  

Follow the step-by step procedures provided in this section if you are going to use a 

Windows PC as the video capture workstation in order to view and record images 

captured by a DVI2PCIe frame grabber. 

 

Note that you should install the drivers and application on the Windows video capture 

workstation after installing the DVI2PCIe in a PCIe slot of the Windows video capture 

workstation. 

 

5.1 To Install the Windows Drivers and Capture 
Application 

The drivers and application software includes the Epiphan device drivers and the 

capture application. 

 

1. Find the latest Windows drivers and Epiphan Capture software. Browse to 

http://www.epiphan.com/products/dvi-frame-grabbers/dvi2usb-3-0//software-

download/. Then scroll down to the Windows section of the download page. 

2. Download the latest version of the drivers and application that will run on the 

video capture workstation.  

Make sure you note the download destination folder. 

3. Unzip the downloaded file. Right-click on the .zip file and choose Extract All. 

4. Select the Setup Utility (setup.exe) from the list of extracted files and follow 

the prompts to install the software. 

The Windows drivers and application software are now installed. If you have 

installed the drivers and application software, the video capture workstation after 

powering on should automatically recognize the frame grabber and install drivers 

for it. 

 

 

http://www.epiphan.com/products/dvi-frame-grabbers/dvi2usb-3-0/software-download/
http://www.epiphan.com/products/dvi-frame-grabbers/dvi2usb-3-0/software-download/
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5.2 Upgrading to the Latest Windows Software 
Version 

From time to time Epiphan makes new versions of all Epiphan Frame Grabber 

software available from the Epiphan web site. To confirm that you have the latest 

video capture application version, select the Check for Updates command from the 

Help menu. 

 

Note: Check for Updates will only recommend an update if Epiphan recommends that 

you install a new version. This will happen if the latest version contains significant bug 

fixes or enhancements. If a new video capture application version only contains minor 

changes, Check for Updates may not recommend that you install a new version. 

 

In most cases you can upgrade the Epiphan software on your Windows video capture 

workstation by using normal procedures for your operating system to download the 

latest version and install it without uninstalling the previous version. If you have 

problems upgrading Windows software, see the detailed driver update instructions and 

install/uninstall instructions available from the Windows section of the Download page. 

 

 

5.3 Finding Software Updates 

 
To find the latest versions of all Epiphan software for Windows, go to 

http://www.epiphan.com/downloads. You can also browse to the download page for 

your DVI2PCIe product. To do so, browse to http://www.epiphan.com and select 

Products > DVI Frame Grabbers > DVI2PCIe. On these pages you will find the most 

recent versions of: 

 

• this Epiphan DVI2PCIe User Guide. 

• the Epiphan USB device driver and video capture application for Windows 2000, 

Windows XP, and Windows Vista. 

http://www.epiphan.com/downloads
http://www.epiphan.com/
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5.4 Troubleshooting a Windows Installation 

If you experience any difficulty viewing captured images with the Windows capture 

application, review the following items prior to contacting technical support. 

 

If you experience any difficulty viewing captured images with the Windows capture 

application, review the following items prior to contacting technical support. 

 

Confirm that the DVI2PCIe is properly installed in its PCIe slot and confirm that the 

Windows Device Manager displays the DVI2PCIe status under System Devices > 

PCIe Bus. Finally, observe the behavior of the frame grabber LED indicators.  

 

If, after following the installation steps, you are still having problems, close all 

applications and restart the video capture workstation. When the video capture 

workstation has started up, open the Windows Device Manager to confirm that the 

frame grabber is detected. 
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6    Linux Video Capture Workstation Software 
Epiphan provides the Epiphan USB device driver and the Epiphan capture API for 

Linux. Epiphan does not provide a video capture application for Linux. However, the 

USB device driver is compatible with Video4Linux so you can use Video4Linux 

compatible applications to receive and process captured images. You can also use 

the Epiphan Linux SDK to write your own custom video capture application that 

receives captured images from the Epiphan capture API. The following software 

components operate on a video capture workstation running Linux: 

 

 The Epiphan USB device driver 

 Video4Linux 

 The Epiphan capture API 

 V4L custom video capture applications 

 

6.1 The Epiphan USB Device Driver 

The Linux Epiphan USB device driver receives images from an Epiphan DVI2PCIe 

and delivers the images to the Epiphan capture API and to Video4Linux. Before 

delivering the images the Epiphan USB device driver also performs image adjustment 

to improve the quality of the image. Image adjustments include setting the sampling 

phase, PLL adjustments, and horizontal shift. The USB device driver can also change 

the color depth of the captured image before sending the image to the video API. For 

example, if the DVI2PCIeis capturing the frames at a color depth that is different than 

that required by the video capture application, the USB device driver converts the 

images to the required color depth. 

 

The Epiphan USB device driver may not be available for your version of Linux. 

Epiphan does not provide source code for the Epiphan USB device driver. But you can 

contact Epiphan if you need an Epiphan USB device driver compiled for a specific 
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Linux kernel version or kernel setting. Using the Epiphan software development kit 

(SDK) you can also create custom USB device drivers that incorporate the functions 

that you need. 

 

6.2 Video4Linux 

Video4Linux (V4L) is a Linux video capture API. The Epiphan USB device driver can 

send captured images directly to Video4Linux. This means that any Video4Linux-

compatible application can receive captured images. You can use a Video4Linux-

compatible application to record a series of captured images as a video in the video 

format supported by the Video4Linux application. You can also create your own 

custom Video4Linux-compatible video capture application to record captured images 

from Video4Linux. 

 

6.3 The Epiphan Capture API 

The Epiphan Capture API also receives captured images from the Epiphan USB 

device driver. It is optimized for processing Epiphan DVI2PCIe captured images. The 

Epiphan Capture API analyzes individual images, performs on-device cropping, and 

handles video mode changes. It is an alternative to using Video4Linux to capture 

images on Linux video capture workstations. You can use the Epiphan software 

development kit (SDK) to create your own custom video capture application to record 

captured images from the Epiphan Capture API. 

 

6.4 V4L Custom Video Capture Applications 
Epiphan does not provide a video capture application for Linux. However, you can use 

Video4Linux-compatible applications to perform many video capture operations such 

as recording images or video, copying, printing and saving images, or broadcasting 

images across the Internet. You can also use the Epiphan Linux SDK to create your 

own custom video capture application. The SDK along with some example 
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applications is available from the downloads page of the Epiphan Web Site. To 

download the latest version, browse to http://www.epiphan.com/products and 

locate the downloads page for your product. 

  

http://www.epiphan.com/products
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7 Connecting DVI2PCIe to a Video Source 
This section describes how to connect a DVI/VGA/HDMI source to the DVI2PCIe. 

Make sure that the following steps are completed: 

1. The frame grabber and the capture application are properly installed on the 

video capture workstation. 

2. The video capture workstation is powered on. 

 

Now connect the DVI2PCIe to the video source using the provided cables. If 

necessary, you can use a high-quality VGA or DVI splitter to split the VGA or DVI 

signal between an external monitor and the frame grabber in order to control the 

output signal quality. 

 

You can connect a DVI source directly to the frame grabber’s DVI In port using a 

standard DVI cable, Figure 5 DVI to DVI Cable.  

 

To connect a VGA source, use a VGA to DVI cable, Figure 4 VGA to DVI Cable. 

 

To connect an HDMI source, use an HDMI to DVI adapter, Figure 6 HDMI to DVI 

Adapter. 
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8 Windows Video Capture Application 

This chapter describes common functions and features of the Epiphan Capture Tool. It 

supports the Windows 2000, XP, Vista and 7 versions. This chapter assumes that you 

have followed the installation and connection instructions in this Guide. To start using 

this chapter you should have:  

 A video signal source started. 

 A video capture workstation running Windows with connected DVI2PCIe.  

 The DVI2PCIe drivers and application installed on the video capture 

workstation. 

8.1 Starting the Windows Video Capture Application  

To start the application, from the Windows Start menu select Start > Epiphan Capture 

Tool. The application starts up and looks for the DVI2PCIe frame grabber connected 

to your PC.  

If the DVI2PCIe is operating, the capture application should find it. The image being 

captured by the DVI2PCIe should immediately appear on the application display.  

If the DVI2PCIe device is not capturing images, the application displays the following 

message: No signal.  

As the application starts, the following messages may appear:  

 Capture device not found - as the application attempts to connect with 

DVI2PCIe device.  

 Detecting Video Mode - as the application connects to a device and then 

determines the video mode of the device. 
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 Tuning Capture Parameters - as the application synchronizes and tunes 

capture settings and image adjustments. 

 No Signal Detected - if the application connects to the DVI2PCIe that is not 

connected to an active video source. 

If the application successfully connects to and synchronizes with the DVI2PCIe 

device, it begins displaying captured images.   

8.2 Pausing, Copying, Saving, and Printing Images 

Once the application is displaying images captured by the frame grabber, you can 

pause, copy, save, and print the current image.  

8.2.1 To pause and resume the image capture:  

1. Select Pause Capture from the Capture menu or from the toolbar click . 

2. While image capture is paused, the application stops receiving new images 

from the device. Pause also pauses video recording and image recording. 

While paused, you can save, print, and copy the captured image.  

3. To resume image capture select Resume Capture from the Capture menu or 

from the toolbar click  again. You can use the following procedure to 

copy the image currently displayed by the application to the video capture 

workstation clipboard.  

8.2.2 To copy a snapshot of the current image:  

1. Select Copy from the Edit menu or select  from the toolbar. You can also 

use the key combination CTRL+C. The current image is copied to the 

clipboard.  

2. Paste the image into a document or other application as a bitmap image. The 

image is pasted as a device independent bitmap image.  
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8.2.3 To save a snapshot of the current image as an image file:  

You can use the following procedure to save the current image as a .bmp, .png, or .jpg 

file on the video capture workstation. You can optionally pause the image capture 

before saving an image.  

1. Select Save from the File menu or from the toolbar select  or use the 

key combination CTRL+S.  

The status bar shows the location and name of the saved file.  

The first time you save an image, the Save As dialog appears and you can 

specify the file name, file type, and location of the saved image file.  

2. When you select Save again, the application saves the new image with the 

same file name and location, overwriting the previously saved file. You can 

select Save As to save the image with a different file name, file type, or 

location or use the key combination CTRL+Shift+S.  

3. You can open the saved image file with most bitmap image editing 

applications.  

8.2.4 To print a snapshot of the current image:  

You can use the following procedure to print the current image on any printer that is 

connected to the video capture workstation. You can optionally pause the image 

capture before printing an image.  

1. Select Print from the File menu, select  from the toolbar or use the key 

combination CTRL+P. The current image is sent to the default printer set in 

your computer. You can select Print Setup from the file menu or use the key 

combination CTRL+Shift+P to select a different printer and set printer 

options.  

Note: You can also configure the application to invert colors for printing. From the 

Tools menu select Options, then select the Display tab and select Invert colors for 

printing.  By reversing or inverting the colors of an image, the colors are made 
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complementary of the original value. After performing picture color inversion, black 

becomes white, yellow becomes blue, and red becomes aqua. 

8.3 Recording Captured Images  

You can record captured images as a video file or as a series of image files.  

8.3.1 To record captured images as a series of image files 

Before recording captured images as a series of image files, you must configure the 

recording options by selecting Options from the Tools menu, then selecting the 

Recording tab, and finally selecting Record as Images. You should also select the 

image file format and other image file settings. Refer to Configuring Recording 

Options. 

1. Select Start Recording from the Capture menu, from the toolbar select  or 

use the key combination CTRL+R. As images are captured by the frame grabber, 

they are recorded as a series of image files according to the image file settings on 

the Recording tab (Tools – Options). The Status bar shows the name and location 

of the last saved file. You can pause recording by using the key combination 

CTRL+U, by selecting Pause from the Capture menu or from the toolbar. You 

can stop recording by selecting repeatedly Stop Recording from the Capture 

menu or  from the toolbar. When you stop recording images, the status bar 

displays the number of image files saved.  

8.3.2 To record captured images as a video file: 

Before recording captured images as a video file, you must configure the recording 

options by selecting Options from the Tools menu, then selecting the Recording tab, 

and finally selecting Record as Video. Refer to Configuring Recording Options. 

1. Select Start Recording from the Capture menu or from the toolbar select  
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. 

2. In the Save as dialog box enter the file name, select the location for saving the 

video file, and click Save. You can record video in AVI format only. 

As images are captured by the frame grabber, they are recorded to the video file. The 

status bar shows the name and location of the video file. The status bar also displays 

the amount of time that the video has been recording and the number of frames (or 

images) being recorded.  

When the size of the video file reaches the AVI file size limit, refer to the AVI file size 

limit field description in the Configuring Recording Options section on how this is set. 

Based on the configurable behavior in that same section, the DVI2PCIe user interface 

does one of the following:  

o stops recording 

o starts a new video file and continues recording (the Configuring 

Recording Options section describes how to specify the file name) 

o overwrites the original video file and continues recording. 

You can pause a recording by selecting Pause Capture from the Capture menu or 

from the toolbar.  

You can stop recording by selecting Stop Recording from the Capture menu or  

from the toolbar.  

When you stop recording, the Status bar shows the name and location of the saved 

video file, the amount of time that the video file was recording, and the number of 

frames or images that were recorded. For example: Wrote c:\temp\example.avi (85 

sec, 464 frames).  
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8.4 Menus  

This section describes the commands available from the following Windows DVI2PCIe 

user interface menus:  

8.4.1 File Menu 

Use the File menu commands to save and print the current image displayed by the 

DVI2PCIe user interface and to exit the DVI2PCIe user interface. 

Save Save a snapshot of the current image to a file on the video capture 

workstation. Select a location for the file and select a file format. 

You can save the snapshot as a bitmap (*.bmp), portable network 

graphics (*.png), or JPEG (*.jpg) file.  

The first time you select Save after starting the DVI2PCIe user 

interface, you are prompted for a file name and you can change the 

file location and format. After saving the first file, every time you 

select Save, the video capture software saves a snapshot using the 

same file name in the same location replacing the previously saved 

file. When you select Save, the status bar shows the location and 

name of the saved file.  

Save As Save a snapshot of the current image to a file on the video capture 

workstation. Using Save As you can enter a file name and select a 

file location and format.  

Save As resets the file name, location, and file format used by the 

Save command and the Save snapshot toolbar button. When you 

select Save As the status bar shows the location and name of the 

saved file.  

Print Setup Configure printer settings used when you select the Print command 

or the Print snapshot toolbar button. You can also configure the 

DVI2PCIe user interface to invert colors for printing. By reversing or 

inverting the colors of an image, the colors are made 

complementary of the original value. After performing picture color 
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inversion, black becomes white, yellow becomes blue, red becomes 

aqua. From the Tools menu select Options, then select the Display 

tab and select Invert colors for printing. 

Print Print a snapshot of the current image using the configured printer. 

Exit Close the DVI2PCIe user interface. 

8.4.2 Edit Menu  

From the Edit menu you can copy a snapshot of the current image. You can also use 

the key combination CTRL+C. 

Copy Copy a snapshot of the current image to the video capture 

workstation clipboard. You can paste this image into a document or 

other application as a bitmap image. 

 

8.4.3 View Menu  

Use the commands on the View menu to control the parts of the DVI2PCIe user 

interface window that are displayed.  

Toolbar Change the size of the toolbar icons or hide the toolbar. You can 

select small, large, or huge icons. You can also hide the toolbar. 

If the toolbar is hidden, select an icon size to display the toolbar. 

Status Bar Enable or disable displaying the status bar. 

Full Screen Enable full screen mode, Ctrl+F. 

Image Only Change the DVI2PCIe user interface to operate in the Image 

only mode. In the Image only mode the DVI2PCIe user interface 

displays the captured image only. The window borders, toolbar, 

status bar and menu bar are not displayed. Scroll bars are 

displayed if required.  
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The Image only mode can be useful for applications such as 

integrating the DVI2PCIe user interface into a custom system. 

You can still use all of the shortcut keys to save and print 

images, start and stop recordings, and to exit from the Image 

only mode. You can always press Alt+F4 to exit from the 

DVI2PCIe user interface.  

You can also use the --borderless command line option to start 

the DVI2PCIe user interface in image only mode. Refer to 

Windows command line options.  

8.4.4 Capture Menu  

Use the commands on the Capture menu to start, stop or pause the capturing and 

recording of images. From the Capture menu you can also select the device that the 

DVI2PCIe user interface receives captured images from if you have more than one 

DVI2PCIe or other Epiphan frame grabbers connected to the network. You can also 

view image adjustment settings and VGA mode settings for the selected device.  

The record functions on the Capture menu record the current image as a video or as a 

series of consecutive image files. Select Options from the Tools menu and use the 

settings on the Recording tab to configure what the DVI2PCIe user interface records. 

Start recording Start recording the current image to a video file or a series of 

image files. 

Pause capture Pause or resume image capturing. If you select pause, the 

DVI2PCIe user interface stops displaying newly captured 

images and the image captured when you selected Pause is 

displayed. Pause also pauses the recording of video and the 

saving of image files. Select pause again to resume the 

displaying of captured images and to resume recording. 

Select device You can use Select Device or the key combination Ctrl+D to 

choose the device that the DVI2PCIe user interface receives 

captured images from. The command finds and lists available 
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DVI2PCIe devices. The list displays the serial number, device 

type, captured image resolution and frequency or status and 

location of each device. You can also use this command to 

select the device to configure with the Configure Device 

command.  

Connect 

network device 

Connect a device recognized on the network. 

Disconnect 

network device 

Disconnect current device. 

Recent network 

devices 

Displays a list of recently viewed devices. 

Enable audio 

capture 

Not used. 

Audio input 

device 

Not used. 

Play captured 

audio 

Not used. 

Configure 

device 

You can view image adjustments for the selected device. You 

can configure image adjustments from the Web admin interface 

or from the Network Discovery Utility.  

You can also select and configure VGA modes for the selected 

device.  

See the Configure Device section for more information 

regarding this function. 

  

8.4.5 Configure Device 

This window allows you to perform various image adjustments and select a required 

VGA mode. The following section illustrates and describes what can be configured 

using which tab. 
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Adjustments tab: 

 

Figure 10 Adjustments tab 

 
 
 

Horizontal shift Configure horizontal shift to offset the captured image 

position. For example, a captured image shifted 

slightly to the right (horizontally) can be corrected with 

minor adjustments to the horizontal shift settings.  

Increasing or decreasing the value entered in the 

Horizontal Shift field shifts the image to the right or 

left. 

Vertical shift Configure vertical shift to offset the captured image 

position. For example, a captured image shifted 

slightly downward (vertically) can be corrected with 

minor adjustments to the vertical shift settings.  
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Increasing or decreasing the value entered in the 

Vertical Shift field shifts the image up or down. 

Set offset/gain 

(brightness/contrast)  

 

The offset and gain settings control the image 

brightness and contrast respectively. Increasing the 

offset control causes the image to become darker. 

Increasing the Gain control gives the image more 

contrast. 

Sampling phase This setting adjusts the vertical synchronization 

properties of the image. You may need to change it 

when there is a repetitive distortion or blurriness on 

the horizontal axis of the image. Adjust the setting in 

small steps until a sharper image is displayed.   

PLL adjustment This setting is used to squeeze or stretch the image 

horizontally. 

Prefer wide VGA mode  

 

This checkbox, when enabled, allows Wide Aspect 

Ratio VGA modes to be displayed by the video 

capture application window. The Epiphan USB device 

driver may not be able to determine whether the video 

source is sending a wide video mode signal. You can 

select this option if your video source uses a wide 

video mode to make sure that the Epiphan USB 

device driver selects a wide video mode. 

YCrCb capture Select this checkbox when you need to capture 

analogue component video with the YCrCb encoding. 
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DirectShow tab: 

Figure 11 DirectShow tab 

 
 

Fix resolution Resolution that is reported to 

DirectShow 

Default image Image sent to DirectShow if there is no 

signal 

Scale image to match stream resolution Use the slider to scale the image 

Flip image vertically Select the checkbox to flip the image 

Limit frame rate to  Specify the frame rate limit 

Fix frame rate Select the checkbox to fix frame rate 
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VGA Modes tab 

VGA Modes tab is not applicable to the DVI2USB 3.0 device. 

 

Advanced tab: 

Figure 12 Advanced tab 

 
 

Auto-adjustment 

interval 

Specify the interval value 

Digital mode 

detection 

- Automatic 

- Single Link 

- Dual Link 

On-board 

compression 

Select his checkbox to enable on-board compression of 

the incoming signal 

Sync level 

adjustment 

Adjust sync level (HSync and VSync) 

 

 



Windows Video Capture Application  

 
35 DVI2PCIe User Guide 

 

  

8.4.6 Tools Menu  

Use the Tools menu to customize basic DVI2PCIe user interface operating settings.  

Web Broadcasting Use this command to broadcast the captured signal, 

refer to Chapter 5, Web Broadcasting, for more details.  

Upload EDID to device Use this command to upload an extended display 

identification data (EDID) file to your device. Refer to 

the section EDID. 

Extended display identification data (EDID) is a data 

structure provided by a digital display to describe its 

capabilities to a video source. It is what enables a 

modern personal computer to know what kinds of 

monitors are connected to it. EDID is defined by a 

standard published by the Video Electronics Standards 

Association (VESA).  

Read EDID from device Use this command to read an extended display 

identification data (EDID) file from the device. 

Measure VGA Mode When requested by Epiphan technical support, you can 

use this command to display low-level information about 

the VGA mode that you are capturing with your Frame 

Grabber. You can copy this information into an email to 

send it to Epiphan technical support. 

Options Configure video recording and display settings.  See the 

section Capture, Recording, and Display Options for 

more information. 
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8.4.7 Help Menu  

Use the Help menu to check for updates and to display information about the version 

of the DVI2PCIe user interface that you are running.  

Note: Check for Updates function will only recommend an update if Epiphan 

recommends that you install a new version. This will happen if the latest version 

contains significant bug fixes or enhancements. If a new DVI2PCIe user interface 

version only contains minor changes or if you are running the current version, Check 

for Updates may not recommend that you install a new version and will not display any 

information.  

8.5 Toolbar  

The toolbar can be used to save, print, or copy the current captured image; to start, 

pause, and stop the recording of the currently captured image. You can use the 

Toolbar command on the View menu to change the size of the toolbar icons or to hide 

the toolbar. You can select small, large, or huge icons. If the toolbar is hidden, you can 

select an icon size to display the toolbar.  

 

Save a snapshot of the current image captured by the DVI2PCIe user 

interface to a file on the video capture workstation. Select a location for 

the file and select a file format. You can save the snapshot as a 

Windows bitmap (*.bmp), portable network graphics (*.png), or JPEG 

(*.jpg) file. 

 

Print a snapshot of the current image to the configured printer. 

 

Copy a snapshot of the current image to the video capture workstation’s 

clipboard. You can paste this image into a document or other application 

as a bitmap image. 

 
Start or stop recording the images being captured by the DVI2PCIe user 

interface. When you start recording, the status bar displays 

RECORDING and also displays information about the image or video file 
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being recorded. When you stop recording, the status bar displays 

information about the saved image files or video file. 

 

Pause or resume image capturing. If you select pause, the DVI2PCIe 

user interface stops displaying captured images. Pause also pauses the 

recording of a video and the saving of image files. Select pause again to 

resume the displaying of captured images and to resume the recording 

of a video. 

 
Not used. 

 

Enable web broadcasting of the captured signal. Refer to Chapter 5, 

Web Broadcasting, for details. 

 

8.6 Status Bar 
 

The status bar displays information about the DVI2PCIe user interface: 

 The location and file name of image or video files saved while recording.  

 Recording status. “RECORDING” means that the DVI2PCIe user interface is 

recording captured images.  

 The data rate is the rate (in MB/s, KB/s, Mbps, and Kbps) of data transfer to 

the DVI2PCIe user interface when it is capturing images. 

 The frame rate that the DVI2PCIe user interface is operating at in frames per 

second (fps).  

 The number of frames or images that the DVI2PCIe user interface has 

displayed since the DVI2PCIe user interface was last started. The number of 

frames is only visible if you select Number of captured frames on the status 

bar from the Display tab of the Options dialog. The number of frames stops 

incrementing and starts flashing if you have paused the image capture. Use 

the Reset counter button to reset the number of frames from the Display tab 

of the Options dialog. 

 The VGA mode and refresh rate of the video source. 
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8.7 Capture, Recording, and Display Options  

This section introduces the options available from the Tools menu when you select the 

Options command. These options control how the DVI2PCIe user interface records 

images, displays images. This application is common to a number of different 

products.  

Note: The functionalities located on the KVM tab are not applied to the DVI2PCIe 

product. 

8.7.1 Configuring Recording Options 

To control how the DVI2PCIe user interface records captured images, select Options 

from the Tools menu and then select the Recording tab. You can record captured 

images as a series of consecutively saved graphic files or as a video file. How the 

DVI2PCIe user interface records images when you start recording from the Toolbar or 

the capture menu depends on how you set the recording options.  

 

On this tab you can select a codec which is used to encoding the captured video 

stream. Codecs are not included in the software package provided by Epiphan for the 

DVI2PCIe frame grabber. You must download them before using the frame grabber. 

For example, you can download an x264 codec pack - a free library for encoding 

H.264/MPEG-4 AVC video streams. 

 

If your computer is running under the 32-bit OS, download 32-bit codecs. For the 64-

bit OS, download 64-bit codecs. 

 



Windows Video Capture Application  

 
39 DVI2PCIe User Guide 

 

 

Figure 13 The Recording tab of the Options window 

 
 

You can select the following options: 

Record as Specify whether video or images are recorded. 

Select Codec Select the codec that is applied for 

compressing the signal. 

AVI file size limit Specify the size limit of the .AVI file where the 

data is recorded to. 

Automatically restart recording Select the checkbox to restart recording 

automatically. This checkbox enables the five 

fields below. 

Overwrite the same file (old 

content will be lost) 

After the video file size limit is reached, delete 

the original file and start recording a new video 
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file with the same name. If you select this 

option the original saved video data is lost. 

Create a new file every time 

recording is restarted 

After the video file size limit is reached, start a 

new video file. You can use the append suffix 

setting to create a unique name for the new file 

or files. 

Append suffix…  When you start a video recording session you 

are prompted to enter a file name. If the file 

exceeds the AVI file size limit, the DVI2PCIe 

user interface starts another file named with the 

original file name appended with a sequential 

numeric suffix. Use the append suffix options to 

specify the format of this suffix.  

 

Each suffix starts with a % sign and can include 

the following characters:  

02, 04, 06, or 08 indicates the number of digits 

to use in numbering the suffix. You can specify 

2, 4, 6, or 8 digits. 

“d” means decimal numbers are used in the 

suffix. 

“X” means hexadecimal numbers are used in 

the suffix. 

The suffix %02d means the saved file names 

would end with two-digit decimal numbers, for 

example: 01, 02, 03, ..., 10, 11 and so on. The 

suffix %04X means the saved file names would 

end with 4-digit hexadecimal numbers, for 

example: 0001, 0002, 0003, ..., 000A, 000B 

and so on. 

…starting with Enter the starting number used in the file name 

suffixes in decimal format. If the suffixes 
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include hexadecimal numbering this decimal 

number is automatically converted to 

hexadecimal.  

 

For example, if you named the video file VID, 

set the suffix to %02d and set starting with to 1, 

the video file names would be VID.avi, 

VID01.avi, VID02.avi, etc. 

Overwrite existing files If you select overwrite existing files, files are 

saved according to the video file recording 

options. Existing files are replaced with the new 

files.  

 

If you do not select overwrite existing files, the 

file number in the suffix of the file name is 

incremented until a file can be saved without 

overwriting an already saved file. 

Automatically turn recording off Specify under what conditions recording turns 

off automatically. 

After … frames have been saved Enter a number of frames. 

After … elapsed Enter a number of time units elapsed. 

8.7.2 Configuring Display Options 

To change display options from the Tools menu, select Options and then select the 

Display tab.  
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Figure 14 The Display tab of the Options window 

 
The following display options are available: 

Display format Specify the format video or image are 

displayed in 

Image scaling Specify whether the image should be 

scaled and how 

Image rotation Specify whether the image should be 

rotated and how 

Resize window on resolution change Select the checkbox to resize window 

when the image resolution is changed 
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Invert colors for printing Select the checkbox to change dark colors 

to light colors and light colors to dark 

colors 

Flip image vertically Flip the image at its vertical axis 

Select the check boxes below to add 

optional indicators to the status bar… 

 

Frame rate Displays frame rate 

Crop rectangle Displays crop status 

Audio format Not used 

Number of captured frames Displays number of captured frames 

Data rate (network grabbers only) The data rate is the rate (in MB/s, KB/s, 

Mbps, and Kbps) that the DVI2PCIe user 

interface is receiving data from the device 

capturing images.  
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8.7.3 Configuring Capture Options 

Use this tab to configure multiple capture options.  

Figure 15 The Capture tab of the Options window 

 
 
 

Enable hardware cropping Select this checkbox to enable cropping 

functionality 

Left, Top, Width, Height Enter the values for the crop rectangle 

Force video mode check every … 

seconds 

Specify how often the application indicates 

the type of the video signal being 

received. Note that although frequent 

video mode detection decreases reaction 
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time when changing video mode, it may 

reduce the frame rate. 

Automatically reconnect network 

grabbers 

Select this checkbox to restore connection 

with the remote frame grabbers in case 

the connection has been lost. Otherwise 

the system connects to the local frame 

grabber, if one exists or displays a 

warning “No frame grabbers found”. In this 

case you need to restore connection 

manually. 

Limit frame rate to … fps Set up the maximum frame rate for the 

video signal 
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8.7.4 Setting On-Screen Text Parameters 

By using this tab you can timestamp the captured video and add some static text. 

Figure 16 The On-Screen Text tab of the Options window 

 
 

Timestamp Select this checkbox to enable setting timestamp parameters 

Static text Select this checkbox to enable setting static text parameters 

Format Specify the timestamp format 

Color Set the color 

Font Set the font and the font size 

Position Set the position for the timestamp or text 

Outline Add an outline to the timestamp or text 
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8.7.5 Configure Startup 

Use this tab to specify what actions the application should perform during startup. 

Figure 17 The Startup tab of the Options window 

 
 

Start in full screen mode When the application starts, it resizes to 

the current resolution of the screen 

Search for network grabber at startup Not used 

 

8.7.6 Sharing 

Use this tab to change web broadcasting compression. Select Override default 

compression settings and adjust the Lossless and Lossy settings. 
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Figure 18 Web Broadcasting Compression Options 

 

 

Lossless compression Lossless compression compresses the images being 

broadcasted without reducing image quality. Increasing 

lossless compression can use a considerable amount of 

the video capture workstation’s CPU resources.  

Lossy compression Lossy compression compresses the images being 

broadcasted by reducing image quality. Lossy 

compression is not as CPU intensive as lossless 

compression.  
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9 Configuring DVI2PCIe from the Windows 
Control Panel 

 

Your DVI2PCIe can be configured from the Windows Control Panel using the Epiphan 

Frame Grabbers icon - . Here you can verify the device’s serial 

number, type and status as well as setup configuration parameters. 

Figure 19 Frame Grabber Configuration Window 

 

To edit the default configuration of the device: 

 

1. Select a frame grabber you want to configure. 

2. Click the Default Configuration button.  

It is similar to the Tools > Options > Configure command in the Epiphan 

Capture Tool.  

3. Edit parameters. 
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4. After editing click OK and select the Use default configuration parameter 

radio button to activate settings. Then click Close. 

To maintain device-specific configuration: 

1. Select the Maintain device-specific configuration radio button. 

2. Click the Configure Device… button. It is similar to the Tools > Options > 

Configure command in the Epiphan Capture Tool.  

3. Edit parameters. 

4. After editing click OK and select the Maintain device-specific configuration 

radio button to activate settings. Then click Close. 
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10 Web Broadcasting 

You can use the information in this chapter to share or broadcast the images captured 

by your DVI2PCIe over the Internet. Note that web broadcasting is available only on 

video capture workstations running Windows. 

To broadcast captured images over the Internet, the video capture application sends 

captured images to an Epiphan web broadcasting portal. Each web broadcast session 

is labelled with the serial number of the DVI2PCIe that is capturing the images. The 

card’s serial number appears on the video capture application title bar.  

Web broadcasting sends the currently captured image only. You cannot broadcast 

saved recordings and the DVI2PCIe’s web broadcasting feature does not include 

sound.  

Note: The web broadcasting feature included with the Epiphan video capture 

application is intended as a demonstration only and has a 10-hour time limit.  

It is important to note that the images broadcasted over the Internet are not secure. 

Potentially anyone can view the web broadcast if they know the correct URL. The web 

broadcasting supported by the video capture application is a relatively limited feature. 

Epiphan’s broadcasting products provide a richer web broadcasting feature set. 

10.1 To set the display format for web broadcasting  

1. Open the DVI2PCIe capture tool application on a video capture workstation 

running Windows. 

2. From the Tools menu select Options. 

3. Select the Display tab. 

4. Set Display Format to RGB 24 bits per pixel. 
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5. Optionally limit the frame rate to reduce the number of images sent over the 

Internet reducing the amount of bandwidth being used. Depending on your 

requirements you may not have to change any other display settings. Refer 

to section, Configuring Display Options for all available display settings. 

6. Select OK to save your changes. 

10.2 Starting a web broadcasting session  

No special setup is required for web broadcasting except that the video capture 

workstation must be able to connect to the Internet. The video capture workstation can 

be connected directly to the Internet or to a LAN that is connected to the Internet.  

Before broadcasting captured images over the Internet you need to set the display 

format to 24 bits per pixel. Please refer to the previous section To set the display 

format for web broadcasting. 

 

 

 

To start a web broadcast: 

1. Connect the Epiphan Frame Grabber to the video source that you want to 

broadcast and to the video capture workstation.  

2. Start the Epiphan capture tool application. 

3. Select Web Broadcasting from the Tools menu or from the toolbar select 

. 

The Start web broadcasting dialog appears. 

Figure 20 Start Web Broadcasting Dialog  
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10.3 Viewing a web broadcasting session  

You can view a web broadcasting session from a web browser running under 

Windows 2000, XP, Vista and 7 versions. The following browsers are now supported:  

- Internet Explorer 

- Firefox 

- Opera 

- Chrome 

- Safari.  

Mobile browsers are also supported if the mobile device is compatible with Java SE. 

The working station and web browser should be running the most recent version of the 

Java plug-in. You can download the plug-in’s latest version from http://www.java.com.  

To view a web broadcast: 

1. Open a web browser and browse to the required URL, for example: 

http://www.vga2web.com/D2P00000.  This URL is supplied by the vga2web 

application as shown on the Figure 20 Start Web Broadcasting Dialog and 

can be advertised to potential viewers of the broadcast. 

A second web browser window appears displaying the message Applet is 

loading. Please wait… The broadcasted image should appear within 10 to 20 

seconds.  

http://www.java.com/
http://www.vga2web.com/D2P00000
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The first web browser window in which the web broadcast URL address was 

entered, displays a message indicating that the web presentation has been 

opened in a new window. You can also use the first window to refresh the 

broadcast or re-open the broadcast window if it is accidentally closed.  

10.4  Changing web broadcasting compression and 
performance  

Normally you should not need to change the default web broadcasting compression 

settings. The default settings reduce the amount of Internet bandwidth used for web 

broadcasting by applying a combination of lossless and lossy compression to the 

images being broadcasted.  

To change the web broadcasting compression, from the Tools menu of the DVI2PCIe 

capture tool select Options and then select Sharing. Select Override default 

compression settings and adjust the Lossless and Lossy settings.  

 

10.5 Troubleshooting web broadcasting performance  

Here are three typical reasons for adjusting web broadcasting compression:  

 If you have a slow Internet connection or if viewers of the web broadcasts 

notice delays you can increase lossless or lossy compression to reduce 

Internet bandwidth usage.  

 If viewers of the web broadcast notice poor image quality you can reduce the 

amount of lossy compression.  

 If the video capture workstation CPU usage is too high during web 

broadcasts or if viewers of the web broadcasts notice delays and you have 

determined that the delays are not caused by low Internet bandwidth. The 

delays could be caused by high CPU usage on the video capture workstation 

resulting in the video capture workstation not being able to process all image 
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data. Lossless compression increases CPU usage, so you can reduce CPU 

usage during web broadcasting by reducing lossless compression. 

Note: You cannot change web broadcasting compression during a web broadcast. 

You must stop the broadcast, adjust the settings and then start the broadcast again.  

Changes made to default web broadcast compression settings are only visible to 

viewers of the web broadcast. Changing these settings does not change how the 

video capture application displays, records, or prints captured images.  
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11 Advanced Topics 
 

11.1 EDID 

Extended display identification data (EDID) is data provided by a video display device 

(usually a monitor) to describe its capabilities to a video source. The video source 

uses the EDID to determine the capabilities of the monitor and, therefore, to 

determine the resolution, color depth and other settings that the monitor will accept. 

11.1.1 About EDID 

EDID is defined by a standard published by the Video Electronics Standards 

Association (VESA). The EDID includes manufacturer name, product type, phosphor 

or filter type, timings supported by the display device, display size, luminance data and 

(for digital displays only) pixel mapping data. EDID is crucial for DVI sources but 

mostly ignored by VGA sources. 

 

When you connect a DVI2PCIe to a video source, the video source sees the 

DVI2PCIe as a monitor. Just like a monitor, the DVI2PCIe contains EDID that is used 

by the video source to determine the video signal to send to the DVI2PCIe. 

 

Usually you would operate a DVI2PCIeusing the factory installed default EDID. 

However, in some cases when you connect a DVI2PCIe to a video source, the video 

source may operate using video settings that you do not want it to operate at. For 

instance, you can control the video source output settings by uploading a custom 

EDID file to the DVI2PCIe. The EDID information in the file restricts the video signal 

that can be accepted by the DVI2PCIe. For example, you can upload a custom EDID 

file to your DVI2PCIethat reports that the DVI2PCIeonly operates at 1040x768. When 

the video source reads the EDID from the DVI2PCIe, the video source will reset to 

operate at 1024x768 as set in the EDID. 

 



Advanced Topics  

 
57 DVI2PCIe User Guide 

 

You can obtain custom EDID files from Epiphan Support. You can also download 

custom EDID files for DVI2PCIe frame grabber from the frame grabber product page 

of the Epiphan web site. This page contains custom EDIDs for single video resolutions 

(for example, 640x480 only, 800x600 only, and 1024x768 only) for each DVI2PCIe. 

This page also contains default EDIDs for each DVI2PCIe. You can use the custom 

EDIDs to restrict the video resolution of the video source connected to the DVI2PCIe. 

You can use the default EDIDs to return your DVI2PCIe to normal operation. 

 

11.1.2 Changing the EDID on your Frame Grabber 

Use the following steps to upload a new EDID to your DVI2PCIe. The uploaded EDID 

is permanently installed in the DVI2PCIe and the DVI2PCIe will always share this 

EDID with the video source.  

 

1. Download an EDID file from the Epiphan web site or obtain an EDID file from 

Epiphan Support. 

2. Disconnect the DVI cable from the DVI2PCIe. Keep the DVI2PCIe connected to 

the video capture workstation USB port. 

3. From the video capture application Tools menu, select Upload EDID and select 

the EDID file. 

4. Wait for the EDID update to complete. This can take several minutes. 

5. Reconnect the DVI cable to the DVI2PCIe. 

6. Set the required resolution on the video source. You may need to disable/re-

enable or reset the DVI port.  

11.1.3 An EDID example 

In this example, a user was viewing the video output from a system using a flat panel 

monitor. The monitor displayed video images at a screen resolution of 640x480. When 

the user replaced the flat panel monitor with a DVI2PCIe, the system changed to 

produce video images at a screen resolution of 720x400. 
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It turned out that the video source preferred to output 720x400, but because the 

original monitor did not support 720x400, the video source was forced to operate at 

640x480. The DVI2PCIe supported 720x400 so the system changed to this 

resolution when the DVI2PCIe was connected to it. 

 

The user wanted to return the video source to operating at 640x480 but could not 

manually adjust the screen resolution. To solve the problem, Epiphan created a 

custom EDID for the DVI2PCIethat excluded support for 720x400. When the user 

uploaded the custom EDID to the DVI2PCIe, the video source returned to operating at 

640x480. 

 

11.2 Windows command line options 

You can use the following command line options to control how the Windows video 

capture application starts up. You can add as many command line options as you 

want in any order. All command line options must start with two dashes. Separate 

command line options with spaces.  

 

--borderless  Start the video capture application in image only 

mode. You can press Esc to exit from image only 

mode. 

--sn <sn> To specify which Frame Grabber to use if more than 

one Frame Grabber is connected to the PC. Similar 

to the Capture menu Select Device command.  

<sn> is the serial number of the Frame Grabber. 

--hs <#> Set the horizontal shift*. The range is -100 to 100. 

--vs <#> Set the vertical shift*. The range is -80 to 80. 

--phase <#> Set the sampling Phase*. The range is 0 to 31. 

--pll <#> Set the PLL adjustment*. The range is -50 to 50. 

--offset <#> Set the offset (brightness)*. The range is 0 to 63. 

--gain <#> Set the gain (contrast)*. The range is 0 to 255. 

--noesc Enter this parameter so that you can disable exiting 

image only mode by Pressing the Esc key. You can 
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always press Alt+F4 to exit from the video capture 

application. 

--topmost To keep the video capture application window on top. 

“*” – Refer to the Configure device section for more details. 

 

 

11.2.1 Creating a Windows Shortcut that Uses Command Line Options 

You can use video capture application command line options by creating a Windows 

shortcut to the video capture application executable file and editing the shortcut to add 

command line options. In the following procedure, the video capture application 

executable file v2ugui2.exe has been installed in the folder C:\Program 

Files\DVI2USB30: 

 

1. Open Windows Explorer and navigate the following path: 

C:\Program Files\DVI2USB30 

2. Right click on the file v2ugui2.exe and select Create Shortcut. Windows creates a 

shortcut file that, depending on your Windows settings, may be named “Shortcut 

to v2ugui2.exe.lnk”. The “.lnk” may not appear if Windows does not display file 

extensions. You can change the name of this file and copy it to another location if 

required. Don’t change the file extension. 

3. Right click on the shortcut file and select Properties. 

4. Edit the Target field and add command line options after the closing quote. For 

example, to add the --topmost command line option: 

"C:\Program Files\DVI2USB30\v2ugui2.exe" –topmost 

For example, to add --topmost and --borderless, set the horizontal shift to -67, 

and the vertical shift to 10: 

"C:\Program Files\DVI2USB30\v2ugui2.exe" –topmost --borderless --hs -67 --vs 

10 

5. Select OK to save your changes to the shortcut. 

6. Double-click on the shortcut to start the video capture application with the 

command line options. 
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13 Software and Documentation License 
 
ATTENTION:  THE SOFTWARE AND DOCUMENTATION PROVIDED UNDER THIS 

AGREEMENT ARE BEING LICENSED TO YOU BY EPIPHAN SYSTEMS INC. (“LICENSOR”) 

AND ARE NOT BEING SOLD.  THIS AGREEMENT CONTAINS LIMITATIONS ON 

REPRESENTATIONS, WARRANTIES, CONDITIONS, REMEDIES, AND LIABILITIES THAT 

ARE APPLICABLE TO THE SOFTWARE AND DOCUMENTATION. 

 
Epiphan 

Software License 
 
IMPORTANT:  BEFORE DOWNLOADING, INSTALLING, OR USING THE SOFTWARE AND DOCUMENTATION, 
PLEASE CAREFULLY READ THIS AGREEMENT WHICH CONTAINS THE TERMS AND CONDITIONS UNDER 
WHICH YOU ARE ACQUIRING A LICENSE TO USE THE SOFTWARE AND DOCUMENTATION. IF YOU DO NOT 
ACCEPT THE TERMS AND CONDITIONS OF THIS AGREEMENT PLEASE DO NOT DOWNLOAD, INSTALL, OR 
USE THE SOFTWARE AND DOCUMENTATION AND PROMPTLY RETURN OR DESTROY THE SOFTWARE AND 
DOCUMENTATION. IF YOU DOWNLOAD, INSTALL, OR USE THE SOFTWARE AND/OR DOCUMENTATION, 
YOU WILL HAVE ACCEPTED AND AGREED TO THESE TERMS AND CONDITIONS. THE SOFTWARE AND 
DOCUMENTATION ARE ALSO PROTECTED BY COPYRIGHT LAWS AND INTERNATIONAL COPYRIGHT 
TREATIES, AS WELL AS OTHER INTELLECTUAL PROPERTY LAWS. IF YOU ARE AN AGENT OR EMPLOYEE OF 
AN ENTITY, YOU REPRESENT AND WARRANT THAT (I) THE INDIVIDUAL ACCEPTING THIS AGREEMENT IS 
DULY AUTHORIZED TO ACCEPT THIS AGREEMENT ON SUCH ENTITY’S BEHALF AND TO BIND SUCH ENTITY, 
AND (II) SUCH ENTITY HAS FULL POWER, CORPORATE OR OTHERWISE, TO ENTER INTO THIS AGREEMENT 
AND PERFORM ITS OBLIGATIONS UNDER THIS AGREEMENT. 
 
1. Definitions:  In this Agreement: 
 
“Agreement” means this Epiphan Software License; 
 
“Documentation” means the technical publications delivered to You with the Software relating to the 
installation and operation of the Software, such as reference, user, installation and technical guides and 
release notes; 
 
“Software” means the Licensor binary and/or bytecode software programs that (i) are made available to 
You for download after acceptance of this Agreement, (ii) are packaged with this Agreement, or (iii) embed 
this Agreement in their installer(s) and which are installed after acceptance of this Agreement, and which 
binary and/or bytecode software programs include any Documentation; and 
 
“You” or “Your” means the individual acquiring the Software license or any entity on whose behalf such 
individual is acting. In the case of an entity, "You" includes any entity that by majority voting interest 
controls, is controlled by, or is under common control with You. 
 
2. Grant of Software License: Subject to the terms and conditions of this Agreement, Licensor grants You 
a non-exclusive, non-transferable, non-sublicensable, internal license to use a reasonable number of copies 
of the Software.  All copies of the Software made by You shall include all trademarks, copyright notices, 
restricted rights legends, proprietary markings and the like exactly as they appear on the copy of the 
Software originally provided to You.  No other rights in the Software or Documentation are granted to You. 
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3. Open Source Software: Binary, bytecode and source code versions of certain open source software 
packages may be embedded in or distributed with the Software (“Open Source Software”).  If a separate 
license agreement for an item of open source software is: delivered to You with the Software; included in 
the download package for the Software; referenced in any material (including the Documentation) that is 
included in the download or distribution package for the Software; or listed at 
www.epiphan.com/opensource, then such open source software shall be Open Source Software and such 
separate license agreement shall govern Your use of that item or version of such open source software.  
The Open Source Software may include free software (i.e. software licensed under the GNU Lesser General 
Public License or other free software licenses) for which the applicable free software license may also 
require that the source code for such free software be made available to those receiving only executable 
versions of such free software.  If the source code for any free software distributed with the Software is 
not provided with the Software, then upon request, within a three (3) year period from the original receipt 
of such Open Source Software from Licensor, for a fee that shall not exceed Licensor's costs associated with 
the shipping of the source code for such free software, Licensor will provide a copy of the source code for 
such free software to You.   
 
4. Restrictions: The terms set forth in this Section 4 shall constitute conditions to the licenses granted in 
Section 2.  You shall not reverse engineer, disassemble, reverse translate, decompile or in any other manner 
decode the Software except to the extent the Software is distributed with any Open Source Software that 
prohibits the imposition of such a restriction or to the extent the foregoing restriction is expressly 
prohibited by applicable law notwithstanding a contractual obligation to the contrary.  You acknowledge 
and agree that no rights in respect to the source code of the Software are granted to You.  You shall not 
distribute, lease, rent, grant a security interest in, assign, or otherwise transfer the Software except as 
expressly provided in this Agreement. You shall not modify or create any derivatives works of the Software 
or merge all or any part of the Software with another program.  You shall not use the Software or make the 
Software available to any third parties as part of any service bureau, time sharing service, application 
service provider offering, software-as-a-service offering or any other managed service offering.  You shall 
not disclose any performance, benchmarking, or feature-related information about the Software. You 
further agree not to disclose, transfer or otherwise provide to any third party any portion of the Software, 
except as expressly permitted herein. 
 
5. Disclaimer of Warranties:  Licensor does not make any representations or provide any warranties or 
conditions in respect to the Software.  EXCEPT FOR ANY WARRANTIES THAT MAY BE PROVIDED IN ANY 
COMMERCIAL AGREEMENT BETWEEN YOU AND LICENSOR, THE SOFTWARE AND DOCUMENTATION ARE 
PROVIDED “AS IS”, WITHOUT ANY REPRESENTATIONS, CONDITIONS, OR WARRANTIES OF ANY KIND. 
WITHOUT LIMITATION, LICENSOR AND ITS LICENSORS, SUPPLIERS, SUBCONTRACTORS AND 
DISTRIBUTORS DISCLAIM ANY EXPRESS OR IMPLIED REPRESENTATIONS, CONDITIONS, AND/OR 
WARRANTIES OF MERCHANTABILITY, MERCHANTABLE QUALITY, NON-INFRINGEMENT, DURABILITY, 
TITLE, SATISFACTORY QUALITY, OR FITNESS FOR A PARTICULAR PURPOSE WHETHER ARISING BY 
STATUTE, COURSE OF DEALING, USAGE OF TRADE, OR OTHERWISE.  EXCEPT AS OTHERWISE EXPRESSLY 
PROVIDED IN ANY COMMERCIAL AGREEMENT, THE ENTIRE RISK OF THE USE OF THE SOFTWARE AND 
DOCUMENTATION SHALL BE BORNE BY YOU.  EXCEPT AS OTHERWISE EXPRESSLY PROVIDED IN ANY 
COMMERCIAL AGREEMENT, NEITHER LICENSOR NOR ANY OF ITS LICENSORS, SUPPLIERS, 
SUBCONTRACTORS AND/OR DISTRIBUTORS MAKE ANY REPRESENTATIONS OR PROVIDE ANY 
CONDITIONS AND/OR WARRANTIES ABOUT THE SUITABILITY OF THE SOFTWARE AND/OR 
DOCUMENTATION OR ABOUT ANY INFORMATION AND/OR DATA THAT MAY BE PROCESSED BY OR 
MADE AVAILABLE USING THE SOFTWARE. 
 
6. LIMITATION OF LIABILITY:  NEITHER LICENSOR NOR ANY OF ITS LICENSORS, SUPPLIERS, 
SUBCONTRACTORS AND/OR DISTRIBUTORS SHALL HAVE ANY LIABILITY TO YOU OR ANY OTHER PERSON 
OR ENTITY FOR ANY DAMAGES ARISING FROM THIS AGREEMENT, RELATING TO THE SOFTWARE OR 
DOCUMENTATION, OR RELATING TO ANY SERVICES PROVIDED TO YOU BY LICENSOR (INCLUDING ITS 
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LICENSORS, SUPPLIERS, SUBCONTRACTORS AND/OR DISTRIBUTORS) IN RELATION TO THE SOFTWARE 
AND/OR DOCUMENTATION FOR ANY INDIRECT, RELIANCE, INCIDENTAL, SPECIAL, PUNITIVE, EXEMPLARY 
OR CONSEQUENTIAL DAMAGES, INCLUDING, BUT NOT LIMITED TO, LOSS OF REVENUE OR PROFIT, LOSS 
OF OR DAMAGE TO DATA, BUSINESS INTERUPTION, LOSS OF DATA, REPLACEMENT OR RECOVERY COSTS, 
OR OTHER COMMERCIAL OR ECONOMIC LOSS, WHETHER ARISING FROM CONTRACT, EQUITY, TORT 
(INCLUDING NEGLIGENCE OR STRICT LIABILITY) OR ANY OTHER THEORY OF LIABILITY, EVEN IF LICENSOR 
(INCLUDING ITS LICENSORS, SUPPLIERS, SUBCONTRACTORS AND DISTRIBUTORS) HAS BEEN ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGES, OR THEY ARE FORESEEABLE.  THE LIMITATIONS IN THIS SECTION 
SHALL APPLY WHETHER OR NOT THE ALLEGED BREACH OR DEFAULT IS A BREACH OF A FUNDAMENTAL 
CONDITION OR TERM OR FUNDAMENTAL BREACH. SOME JURISDICTIONS DO NOT ALLOW THE 
EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, SO THESE 
LIMITATIONS MAY NOT APPLY TO YOU. IN NO EVENT SHALL THE TOTAL CUMULATIVE LIABILITY OF 
LICENSOR (INCLUDING ITS LICENSORS, SUPPLIERS, SUBCONTRACTORS AND DISTRIBUTORS) TO YOU OR 
ANY OTHER PERSON OR ENTITY FOR ANY DAMAGES ARISING FROM THIS AGREEMENT, RELATING TO THE 
SOFTWARE, DOCUMENTATION AND/OR RELATING TO ANY SERVICES PROVIDED TO YOU BY LICENSOR 
(INCLUDING ITS LICENSORS, SUPPLIERS, SUBCONTRACTORS AND DISTRIBUTORS) IN RELATION TO THE 
SOFTWARE AND/OR DOCUMENTATION, EXCEED THE LICENSE FEES PAID BY YOU FOR THE SOFTWARE. 
 
THE DISCLAIMER OF REPRESENTATIONS, WARRANTIES AND CONDITIONS AND LIMITATION OF LIABILITY 
CONSTITUTE AN ESSENTIAL PART OF THIS AGREEMENT. YOU ACKNOWLEDGE THAT BUT FOR THE 
DISCLAIMER OF REPRESENTATIONS, WARRANTIES AND CONDITIONS AND LIMITATION OF LIABILITY, 
NEITHER LICENSOR NOR ANY OF ITS LICENSORS OR SUPPLIERS WOULD GRANT THE RIGHTS GRANTED IN 
THIS AGREEMENT. 
 
7. Term and Termination:  This Agreement shall continue for as long as You use the Software, however, it 
may be terminated sooner as provided in this Section 7.  You may terminate this Agreement by destroying 
all copies of the Software and Documentation under Your control and providing certification of such 
destruction to Licensor or by returning the Software to Licensor.  Licensor may terminate this Agreement 
immediately by providing You with written notice if: (a) You are in material breach of any provision of this 
Agreement, which breach, if capable of being cured, is not cured within thirty (30) days after Licensor gives 
You written notice thereof; or (b) You have committed a non-curable material breach of this Agreement.  
Upon termination You shall destroy all copies of the Software.  In addition to this Section, the Sections 
entitled Definitions, Disclaimer of Warranties, Limitation of Liability, Title, High-Risk Activities, Intellectual 
Property, and General shall continue in force even after any termination of this Agreement.  No termination 
of this Agreement will entitle You to a refund of any amounts paid by You to Licensor or affect any 
obligations You may have to pay any outstanding amounts owing to Licensor.  Upon any termination by 
Licensor, You shall destroy all copies of the Software and Documentation under Your control and certify 
such destruction to Licensor. 
 
8.  Support and Updates:  This Agreement does not grant You the right to any updates or enhancements 
of the Software or the right to receive any technical support for the Software. Such updates and other 
technical support services, if available, may be purchased separately from Licensor.  Use of any updates or 
enhancements to the Software provided pursuant to any technical support You may procure from Licensor 
shall be governed by the terms and conditions of this Agreement.  Licensor reserves the right at any time 
not to release or to discontinue the release of any Software and to alter prices, features, specifications, 
capabilities, functions, licensing terms, release dates, general availability or other characteristics of the 
Software. 
 
9.  Title:  All right, title, and interest (including all intellectual property rights) in, to, and under the Software 
(including all copies thereof) shall remain with Licensor and its licensors. 
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10. High-Risk Activities:  The Software is not fault-tolerant and is not designed, manufactured or intended 
for use in or in conjunction with on-line control equipment in hazardous environments requiring fail-safe 
performance, such as in the operation of nuclear facilities, aircraft navigation systems, air traffic control, 
or direct life support machines. Licensor, its licensors, suppliers, subcontractors and distributors specifically 
disclaim any express or implied representations, warranties and/or conditions for such uses. 
 
11. U.S. Government End-Users:  The Software and Documentation are each a "commercial item" as that 
term is defined at FAR 2.101, consisting of "commercial computer software" and "commercial computer 
software documentation" as such terms are defined in FAR 12.212, and are provided to the U.S. 
Government only as commercial end items. Government end users acquire the rights set out in this 
Agreement for the Software and Documentation consistent with: (i) for acquisition by or on behalf of 
civilian agencies, the terms set forth in FAR12.212; or (ii) for acquisition by or on behalf of units of the 
Department of Defense, the terms set forth in DFARS 227.7202. Use of the Software and Documentation is 
further restricted by the terms and conditions of this Agreement.  For the purposes of any applicable 
government use, the Software and Documentation were developed exclusively at private expense, and are 
trade secrets of Epiphan Systems Inc. for the purpose of any Freedom of Information legislation or any 
other disclosure statute, regulation or provision. 
 
12. Export Restrictions:  The Software, Documentation and related information are subject to export and 
import restrictions. By downloading, installing, or using the Software, Documentation and/or related 
information, You are representing and warranting that You are not located in, are not under the control of, 
and are not a national or resident of any country to which the export of the Software, Documentation 
and/or related information would be prohibited by the laws and/or regulations of Canada or the United 
States. You are also representing and warranting that You are not an individual to whom the export of the 
Software, Documentation or related information would be prohibited by the laws and/or regulations of 
Canada or the United States. You shall comply with the export laws and regulations of Canada and the 
United States that are applicable to the Software, Documentation and related information and You shall 
also comply with any local laws and/or regulations in Your jurisdiction that may impact Your right to export, 
import, or use the Software, Documentation or related information, and You represent and warrant that 
You have complied with any such applicable laws and/or regulations. The Software, Documentation and 
related information shall not be used for any purposes prohibited by export laws and/or regulations, 
including, without limitation, nuclear, chemical, or biological weapons proliferation. You shall be 
responsible for procuring all required permissions for any subsequent export, import, or use of the 
Software, Documentation or related information. 
 
13. Intellectual Property:  Epiphan is a trademark or a registered trademark of Epiphan Systems Inc. in 
certain countries.  All Licensor product names and logos are trademarks or registered trademarks of 
Epiphan Systems Inc. in certain countries. All other company and product names and logos are trademarks 
or registered trademarks of their respective owners in certain countries.  You shall not disclose, transfer or 
otherwise provide to any third party any portion of the Software, except as expressly permitted in this 
Agreement. 
 
14. General:  This Agreement is the entire agreement between You and Licensor in respect to the Software, 
superseding any other agreements or discussions, oral or written. The terms and conditions of this 
Agreement shall prevail over any pre-printed terms on any quotes, orders, purchase orders, or purchase 
order acknowledgements, and shall prevail over any other communications between the parties in relation 
to the Software. You may not assign this Agreement whether voluntarily, by operation of law, or otherwise 
without Licensor’s prior written consent. Licensor may assign this Agreement at any time without notice. 
The failure of a party to claim a breach of any term of this Agreement shall not constitute a waiver of such 
breach or the right of such party to enforce any subsequent breach of such term. If any provision of this 
Agreement is held to be unenforceable or illegal, such decision shall not affect the validity or enforceability 
of such provisions under other circumstances or the remaining provisions of this Agreement and such 
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remaining provisions shall be reformed only to the extent necessary to make them enforceable under such 
circumstances.  This Agreement shall be governed by the laws of the Province of Ontario and the laws of 
Canada applicable therein. No choice or conflict of laws rules of any jurisdiction shall apply to this 
Agreement.  You shall only be entitled to bring any action or proceeding arising out of or relating to this 
Agreement, the Software, Documentation or any services provided in respect to the Software and/or 
Documentation in a court in Ottawa, Ontario, Canada, and You consent to the jurisdiction of such courts 
for any such action or proceeding. You waive all rights that You may have or that may hereafter arise to 
contest the jurisdiction of such courts for any action or proceeding brought by You. You hereby waive any 
right You may have to request a jury trial with respect to any action brought by You in connection with this 
Agreement, the Software or any services provided in respect to the Software. The application of the United 
Nations Convention on Contracts for the International Sale of Goods to this Agreement is expressly 
excluded.  
 
February 2017 
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Environmental Information  

The equipment that you bought has required the extraction and use of natural 

resources for its production. It may contain hazardous substances that could impact 

health and the environment.  

In order to avoid the dissemination of those substances in our environment and to 

diminish the pressure on the natural resources, we encourage you to use the 

appropriate take-back systems. Those systems will reuse or recycle most of the 

materials of your end life equipment in a sound way.  

The crossed-out wheeled bin symbol invites you to use those systems. If you need 

more information about collection, reuse and recycling systems, please contact your 

local or regional waste administration. You can also contact us for more information on 

the environmental performance of our products.  

 

FCC & CE Compliance Statement 

 

This device complies with Part 15 of the FCC Rules. Operation is subject to the 

following two conditions: 

(1) This device may not cause harmful interference 

(2) This device must accept any interference received, including interference that may 

cause undesired operation. 

Marking by the symbol indicates compliance of this device with EMC directive of 

the European Community and meets or exceeds the following technical standard.  

EN 55022 - Limits and Methods of Measurement of Radio Interference Characteristics 

of Information Technology Equipment. 
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Other Jurisdictional Issues  

Epiphan makes no representation that its products or information in this document or 

its web site is appropriate or available for use in your jurisdiction. Those who choose 

to access the Epiphan web site or use Epiphan products do so on their own initiative 

and are responsible for compliance with local laws, if and to the extent local laws are 

applicable.  

 

Submissions to Epiphan and Affiliated Servers  

Any information, including but not limited to remarks, suggestions, ideas, graphics, or 

other submissions, communicated to Epiphan through their Epiphan web site is the 

exclusive property of Epiphan. Epiphan is entitled to use any information submitted for 

any purpose, without restriction (except as stated in Epiphan's Privacy Statement) or 

compensation to the person sending the submission. The user acknowledges the 

originality of any submission communicated to Epiphan and accepts responsibility for 

its accuracy, appropriateness, and legality.  

 

Third Parties and Links to Third-Party Web Sites 

Mention of non-Epiphan Systems Inc. products or services on their website, or this 

document site is for informational purposes and does not constitute an endorsement 

or recommendation.  

 

This document may contain links to non-Epiphan web sites. These links are provided 

to you as a convenience, and Epiphan is not responsible for the content of any linked 

web site. Any outside web site accessed from the Epiphan web site is independent 

from Epiphan, and Epiphan has no control over the content of that web site. In 

addition, a link to any non-Epiphan web site does not imply that Epiphan endorses or 

accepts any responsibility for the content or use of such a web site.  

In no event shall any reference to any third party or third party product or service be 

construed as an approval or endorsement by Epiphan of that third party or of any 
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product or service provided by a third party.  

 

Miscellaneous 

It is the user's responsibility to ascertain whether any information downloaded from the 

Epiphan web site or other websites is free of viruses, worms, trojan horses, or other 

items of a potentially destructive nature.  

 

Enforcement of Terms and Conditions  

These Terms and Conditions for use of this document and the associated Epiphan 

Product are governed and interpreted pursuant to the laws of the province of Ontario, 

Canada, notwithstanding any principles of conflicts of law.  

 

All disputes arising out of or relating to these Terms and Conditions shall be finally 

resolved by arbitration conducted in the English language in Ottawa, Ontario, Canada 

under the commercial arbitration rules of the Canada. The parties shall appoint as sole 

arbitrator a retired judge who presided in the province of Ontario. The parties shall 

bear equally the cost of the arbitration (except that the prevailing party shall be entitled 

to an award of reasonable attorneys' fees incurred in connection with the arbitration in 

such an amount as may be determined by the arbitrator). All decisions of the arbitrator 

shall be final and binding on both parties and enforceable in any court of competent 

jurisdiction. Notwithstanding this, application may be made to any court for a judicial 

acceptance of the award or order of enforcement. Notwithstanding the foregoing, 

Epiphan shall be entitled to seek injunctive relief, security, or other equitable remedies 

from any court of competent jurisdiction.  

If any part of these terms is unlawful, void, or unenforceable, that part will be deemed 

severable and will not affect the validity and enforceability of the remaining provisions. 

Epiphan may, at its sole discretion and without notice, revise these terms at any time 

by updating this posting. 

 

Copyright © 2013 Epiphan Systems Inc.  

All Rights Reserved. 

 


